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MMMeeeeeetttiiinnngggsss   NNNoootttiiiccceee   

   
We are limited to one meeting a 

month for 2010 by the 
library.  EPCC will have 10 
main meetings in 2010, 
but there will be no 

meeting dates available in 
July and November.  All 

meetings will be held at 6:30 
pm on the first Monday of the month (except 
September which will be the second Monday 
because of the holiday). 

 
Presentation meetings - Struble Room 

 
Board meetings - Board Room 

 
Meetings start at 6:30 pm.      

 

 
Future Meeting Topics may include:  
Finance for Home, Quicken and Migration 

from 1 pc to another, etc.  
 

 

 

< - - Next Meeting - - >  

August 2 
Free Software-Overview 

 

-with Izzi Bourrie 
 

Everyone uses their computer and internet 
differently with their own particular programs 
and tools as favorites.  Some of the 
membership has provided a list of their own 
commonly used ones - many of these are free.  
Furthermore, almost all functions these days 
can be performed with free software.  At the 
August meeting we will explore some of these 
free programs showing where you can get and 
how you can use them.  You may never have 
to buy software again.  A few of the programs 
to be discussed are: 

Picassa:  to organize and process your photos 

Primo PDF: to create PDF files and print to 
them instead of paper 
CCleaner: to clean up your computer and 
make it run faster. 
Snapshot: to capture information on the 
screen for later use and reference 
There will be several others as well including a 
program to show what’s in and on your 
computer, and one to find the product codes 
of installed programs. Come and see all that 
you can do for free.   

THE EXTON PC COUNCIL www.ExtonPC.org 
 

All meetings are free and open to the public   ==    Bring a friend 
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< - - Future Meetings - - >             

August 11 
Board meeting 

September 8 
Board meeting 

September 13 
Protect Yourself Against Identity Theft 

With George Bourrie 

There are many ways that your personal 
information may be accessed by people who 
shouldn’t have it.  On a computer, some of 
these are not having adequate firewall, 
antivirus, and antispyware software running, 
your having chosen guessable passwords, your 
revealing too much on social sites, using public 
networks to transmit personal data, installing 
software from unknown sources, and 
succumbing to e-mail scams.  Off of a 
computer, there is tossing information in the 
trash, revealing too much to unknown callers 
on the telephone, etc.  At this presentation, 
tactics for dealing with these issues will be 
discussed for protecting yourself against 
Identity Theft.  

October 4 
Preview:  Jack Stretch will present a Best Buy 
presentation with a guest speaker on all latest 
electronic items for Christmas presents.  Keep 
posted in future newsletters for more 
information. 

October 13 
Board meeting 

November 
No Monday Meeting  

November 10 
Board meeting 

December 6 

Open House: 
Includes Net books, Saving Memories, 
Latest Anti-Virus and much more…    

 
December 

No Board meeting  

Q.&A.:  

Updating a Digital Cameraôs Software 
By J.D. BIERSDORFER 
 
Q.  I have read that updating a digital camera’s system 
software can help with buggy performance, but how 
do you do it? 
A. Updating a camera’s software (also known as 
firmware) can improve its stability and overall 
performance. You typically upgrade firmware with 
downloaded software and the U.S.B. cable connected 
to your computer. Your camera’s manual should have 
the exact steps for your model. 

You should start by checking if there are any firmware 
updates for your particular camera. You can do this by 
visiting the manufacturer’s Web site and checking in 
the Support area for anything related to your camera’s 
model. If you can’t find the camera’s manual, you can 
often download a copy of it as a PDF file. On some 
sites, you can also search the Support area for 
“firmware” to see what’s available; Nikon’s site has an 
example. 

Although the camera manufacturer should have the 
precise instructions for updating the software, the 
basic steps typically start with downloading the 
firmware update files from the Web site and 
uncompressing them. Select a blank memory card and 
make sure it’s formatted for use in the camera. With 
the camera’s U.S.B. cable, connect the camera to the 
computer in PC mode. You may also be able to use a 
memory-card reader connected to one of the 
computer’s a U.S.B. ports instead. 

http://gadgetwise.blogs.nytimes.com/author/jd-biersdorfer/
http://support.nikontech.com/app/answers/detail/a_id/13783/session/L3NpZC9tUE5PbjUyaw%3D%3D/kw/firmware/p/19/r_id/116678/sno/1
http://support.nikontech.com/app/answers/detail/a_id/13783/session/L3NpZC9tUE5PbjUyaw%3D%3D/kw/firmware/p/19/r_id/116678/sno/1
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Once the memory card shows up on the computer as 
an attached device, drag the firmware folder from the 
computer to the memory card to copy it over. 
Disconnect the camera from the U.S.B. cable and start 
the camera in its Setup mode. The camera’s menus 
should guide you through the rest of the steps for the 
upgrade. When you are finished, restart the camera 
and reformat the memory card again so you can use it 
for storing pictures. 

 

http://gadgetwise.blogs.nytimes.com/2010/06/22/q-a-

updating-a-digital-cameras-software/ 

 

New York Times 24 June 2010 

Contributed by:  Joseph Holzman  

 

WORD AND EXCEL TIPS: 
 

Inserting a Non-Breaking Hyphen 
When Microsoft Word calculates line length and wraps 

text to the next line, it tries to wrap (or break) the line at 

a space or a hyphenða dash. Sometimes, however, you 

may not want Word to break a line at a dash. For 

instance, dashes are used in telephone numbers, and 

you might not want a line to break in the middle of a 
telephone number. 

The answer is to use non-breaking hyphens instead of 
regular dashes when you don't want Word to break a 
line at the hyphen. To do this, hold down the CTRL and 
SHIFT keys as you type the dash (this is the same as 
typing CTRL and an underscore). Word will then not 
break the line at that point. 

You can also insert a non-breaking hyphen by following 
these steps: 

1. Choose Symbol from the Insert menu or, in 
Word 2007, display the Insert tab of the 
ribbon, click Symbol in the Symbols group, 
and finally click More Symbols. This displays 
the Insert Symbol dialog box. 

2. Click on the Special Characters 
tab.

 

The Special Characters tab of the Symbol dialog box. 

3. Highlight the Nonbreaking Hyphen character. 

4. Click on Insert. 

5. Close the dialog box by clicking on Cancel. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Word tips can be 
found online at http://word.tips.net. 

 

 

Indenting Cell Contents 
Microsoft Excel allows you to format the contents of a 
cell in a myriad of ways. One of the formatting options 
you can apply is to indent the contents of a cell by a 
certain amount. This is similar to indenting done in a 
word processor, such as Microsoft Word, except that 
the indenting is specified in a number of characters, 
not in a linear distance such as inches or points. 

To set the indent to be used in a cell, follow these 
steps: 

1. Select the cells you want to format. 

2. Display the Format Cells dialog box. (In Excel 
2007 display the Home tab of the ribbon and 
click the small icon at the lower-right corner 
of the Number group. In older versions of 
Excel choose Cells from the Format menu.) 

3. Make sure the Alignment tab is selected. 

http://gadgetwise.blogs.nytimes.com/2010/06/22/q-a-updating-a-digital-cameras-software/
http://gadgetwise.blogs.nytimes.com/2010/06/22/q-a-updating-a-digital-cameras-software/
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The Alignment tab of the Format Cells dialog box. 

4. In the Horizontal drop-down list, choose Left 
(Indent). If you are using Excel 2002 or a later 
version, you can also choose Right (Indent). 

5. Using the Indent control, specify the number 
of characters by which the cell contents 
should be indented from either the left or 
right side of the cell. You can pick any whole 
number between 0 and 15. 

6. Click on OK. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net. 

 

Fact or Fiction? Busting Common PC 

Optimization Myths  

 

By: Tibor Schiemann, President and Managing 

Partner, TuneUp 
 

People are often looking for ways to improve their 

PCsô performance or speed, but not all of the tips 

out there really work. In fact, some are outright 

wrong and can even slow down your system. Letôs 

go through some of the most popular, enduring 

myths.  

 

Windows Prefetch folders  

The Prefetch folder memorizes the data a program 
needs when it starts, so that your system can 
easily get this data and load the program more 
quickly. There’s a theory lurking around that 
deleting this data saves memory. But the truth is, 
this forces the PC to search for the information it 
needs every time you want that program to start, 
causing it to actually slow down.  
 
Some people believe that Windows automatically 
loads Prefetch information for all of the programs 
you’ve ever started on your computer into 
memory, filling your RAM with unused data. But 
this isn’t true. You don’t need to delete this folder 
because, contrary to popular belief, if you don’t 
run a program, Windows does not access the 
Prefetch information. And what’s more, Windows 
only maintains a maximum of 128 entries in the 
Prefetch folder and automatically cleans itself.  
 

In fact, TuneUp has even tested this. We looked at 
the boot-up performance, as well as the load 
times, of the three, most used applications—
Outlook 2007, Windows Media Center, and 
Internet Explorer 8—on a particular PC, before 
and after cleaning out the Prefetch folder. We 
actually found a noticeable slowdown after 
removing the Prefetch contents. 
 

The ñDr. Watsonò program 

ñDr. Watsonò is a debugging tool for applications. 

If a program crashes, ñDr. Watsonò jumps in, 

collects data and, if you choose to do so, manually 

transfers this data to support personnel to diagnose 

the problem. The data is stored in a file and can be 

immediately sent to Microsoft. There is a rumor 

that ñDr. Watsonò slows down your computer.  

 

But based on a productivity benchmark we 

conducted with PCMark Vantage, we found that 

there werenôt any noticeable differences, regardless 

of whether ñDr. Watsonò was enabled or not. ñDr. 

Watsonò doesnôt affect performance in Windows 

XP, and itôs not even a factor if youôre using Vista 
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or 7, as it doesnôt even exist in these newer 

Windows versions.  

 

ñSecretò CPU settings  

Thereôs another myth circulating in the Windows 

community that a ñsecretò CPU setting can 

improve boot-up time. The rumor claims that 

Windows Vista and Windows 7 only use a single 

processor core during the boot-up process. Yet 

almost all of the machines built today have at least 

two, four, and sometimes even six processor cores. 

So, it may make sense to think that, by enabling 

the other cores, you can speed up the boot-up time.  

 

However, TuneUp tried to enable the other cores 

on three different machines and didnôt find any 

difference among the PCsô boot-up times, even 

when we just used one core. Your best bet is to 

leave this setting alone. We found out that 

sometimes modifying this setting may actually 

cause a userôs machine to crash, and instead advise 

that you stay as far away from this ñtweakò as you 

can.  
 

People are always looking for ways to optimize 

their PCs and are sometimes susceptible to 

schemes that sound good initially but can actually 

harm their machines. TuneUp will continue to look 

into credible ways to enhance PC performance and 

let you know what works best. To keep up with our 

tips, check out our blog at: http://blog.tune-

up.com/. 

  

Music-- Capture it, Organize it and Enjoy it 
by Phil Sorrentino 
Member, the Sarasota Personal Computer Users Group, Inc. 
Music in the past was captured and made available on 
analog sources and played back on analog devices. Those 
analog sources were tubes (in Thomas Edison’s times), 
record disks (78s, 45s and 33 1/3 vinyl), and finally tapes 
(reel-to-reel, 8 track, and cassette). And they were played on 
a phonograph (circa late 1870s), a turntable (spanning the 
20th century) or a tape machine (spanning the late 20th 
century). All those devices were engineered to convert the 
analog music on the source media to sound that eventually 
hit our ears. Analog music was the capture of some sort of 
wiggle, like the wiggle of a turntable needle or stylus, or the 
wiggle of a magnetic field on a magnetic tape. The quality of 
the music we experienced improved all along the time that 

analog music was available, finally culminating in High 
Fidelity, Stereophonic Sound. Stereophonic because there 
are two tracks, one for the right and one for the left, to 
match the hearing mechanisms on our head, one on the 
right and one on the left. High Fidelity is the property of 
reproducing all of the music frequencies that were originally 
produced by the original source, like a singer’s voice, or a 
rock and roll band, or a symphony orchestra. The frequency 
response of the human ear is about 20 Hz to around 16,000 
Hz (although sometimes it is stated as 20 to 20k). These are 
general ranges and as we age, the lower limit tends to rise 
and the upper limit tends to be lowered. (By the way, if 
someone is exposed to very high intensity sounds or noises 
{measured in decibels}, their hearing range could be 
affected. In fact, sounds greater than somewhere around 
100 decibels {db} can produce permanent damage to ones 
hearing range.) So, High Fidelity Stereo was developed to 
deliver two channels, each with about a 20 to 16,000 Hz 
frequency range. What more could you ask for. (Well, 
actually now with digital reproduction you can have much 
more, like 5.1 surround sound, but that is a subject for 
another time.) 

Enough of the past, now on to the digital music age. 
One of the differences between analog and digital 
sources of music is the fact that with an analog source, 
the music quality deteriorates with each play. Each 
time a record or tape is played, some of the range of 
the music is lost. But with digital sources (digital files), 
the quality always remains the same. Go ahead and 
play away. The reason for this is that the digital 
representation for music is just a series of ones and 
zeros (which is reproduced exactly with every Copy). 
As long as that series is reproduced (and the process 
that interprets the ones and zeros doesn’t change), 
then the results, the music, will always be the same. 
So, once we get the music, we have it at that quality, 
for good. But how is digital music created? What is the 
source? And what devices are used to reproduce it.  
The recording process starts with (analog) 
microphones which produce a small analog signal. This 
signal is amplified and then digitized. From this point 
on everything is digital, therefore perfectly 
reproducible. Digitization produces a file that has been 
engineered to contain the complete audible frequency 
range. This is the .wav file that is on the CD that is 
purchased. The CD becomes the source for the music. 
(Today, most music is distributed on CDs, although 
more and more music is being downloaded to 
computers for eventual listening.) Typically there are 
about 15 songs on a CD, but with the capacity of a CD 

http://blog.tune-up.com/
http://blog.tune-up.com/
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(700 MB) and the average size of a song (35MB), you 
might get as many as 20 or 21 songs on a CD. So, if CDs 
are the source of the music, a CD player is the device 
that is used to reproduce the music. CD players come 
in two basic varieties, stereo cabinet type to be used 
with a stereo system maybe in the family room, and 
portables for use on the go. Some larger stereo cabinet 
models can hold as many as 400 CDs and provide a 
place to store all the CDs (without their cases). Now 
that’s how the digital music is produced, distributed, 
and played, but what about MP3s? Well, an MP3 file is 
the result of processing a WAV file with an MP3 
conversion program, the product of which is much 
smaller than the original. (WMA is another file type 
similar to MP3 that has been introduced and used by 
Microsoft.) MP3 files are typically one tenth the size of 
the corresponding WAV file. The resultant file size can 
vary because there are settings used by the MP3 
conversion program. The MP3 conversion process is a 
“Lossy” conversion, that is, some of the quality can be 
lost in the conversion. The quality is selected by 
choosing a bit rate for the conversion. For music this 
rate typically goes from 128 kbps (considered near CD 
quality) up to around 320 kbps (for those audiophiles 
that have very good hearing and reproduction 
systems). There are also lower qualities for low 
frequency range (voice only), files which are 32 kbps 
and 64 kbps. The lower the quality, the smaller the size 
of the MP3 file, and similarly, the higher the quality, 
the larger the file size. Some people might be able to 
detect the difference between a 128 kbps quality and a 
320 kbps quality, but if you cannot then the smaller file 
would be a better choice. (If you’re not sure if you can 
detect the difference, create an MP3 of one of your 
favorite CDs at two different bit rates and then play 
each one and see if you can tell the difference. If you 
can tell the difference, use the higher bit rate as your 
quality setting.) 
So, with that bit of background, we are able to discuss 
the process of converting songs on a CD to MP3 files. 
This process is called Ripping a CD. (Don’t blame me, I 
didn’t name it.) The process does nothing like its name 
implies, it simply converts the WAV file on the CD to an 
MP3 file on the computer, at the chosen quality. 
Ripping can be done with many programs like 
Windows Media Player, Musicmatch Jukebox, 
Audacity, and Winamp. (Windows Media Player (WMP) 
which comes with all Windows Operating Systems will 

be used here in examples.) To Rip a CD, place the CD in 
the CD/DVD reader/writer tray, start WMP, and click 
Rip on the top Selection Bar. It’s that easy. A list of the 
files on the CD will be shown with a checked check box 
for each. If you don’t want one of the songs, uncheck 
the box. When the conversion is finished you will have 
an MP3 file for each of the checked songs. Typically, 
the MP3 files will be in a Folder with the name of the 
CD Album, within a Folder for the Artist within the 
folder that was setup as the Rip Folder. From this 
folder, you can move or copy the songs to a library 
folder. Most people will probably use the Music (or My 
Music) folder that is part of Windows for this. 
Next month we’ll discuss organizing the Library to take 
advantage of the fruits of your (possibly) considerable 
labor in creating the music files. And don’t forget: 
backup all that music regularly, so you don’t have to go 
through that process again. : 

 
Copyright 2010. This article is from the July 2010 issue of the 
Sarasota PC Monitor, the official monthly publication of the 
Sarasota Personal Computer Users Group, Inc., P.O. Box 
15889, Sarasota, FL 34277-1889. Permission to reprint is 
granted only to other non-profit computer user groups, 
provided proper credit is given to the author and our 
publication.  
 

Never  Lose a  Manual Again  

by Linda Gonse, ORCOPUG 

I just found my old Sharp PDA, discovered it was still 

working, and decided to put it to use again. The 

downside was the manual was gone. An Internet 

search showed the original manual available, but 

prices ranged from $20 to $39! The Sharp device began 

to look obsolete to me. Then, I discovered 

retrevo.com. It boasts a library of more than 100,000 

downloadable manuals from more than 1,000 brands 

of consumer electronics for consumer electronics 

searchable by category and brand at 

http://www.retrevo.com/samples/index.html. My 

manual was there and it was free. In seconds, I 

downloaded it. There are more than 100 categories to 

search for manuals: 
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(Continued: Never Lose a Manual Again) 

There are more than 100 categories you can search for 

manuals: 

2-way Radio  Air Conditioner  Amp 

 Binocular  Blender 

 Boombox  

Bread Maker  CD Player  CRT TV

 Calculator  Camcorders  Car 

Amplifier  

Car Receiver  Car Video  Cell Phone Clock 

Radio  Coffee Maker  Controller 

Copier  DVD Drive  DVD Players DVR  Desktop  Digital Camera 

Digital Photo Frame  Dishwasher 

 Dreamcast Game Dryer  Fax 

Machine  Film Camera 

Food Processor  Freezer  GPS GPS 

Accessory  Game Boy Game Console 

Game Cube Game  Gaming Accessory  Graphics 

& Publishing Grill Guitar  Headphone Headset   

Heating Cooling/ Air  Home Theater Hub  Karaoke System  Keyboard LCD TV  

Labeling System Laptop MP3 Accessory  MP3 

Player  Microwave Mini Audio System 

Monitor  Mouse Multifunction Printer  Music Keyboard  NIC Network Adapter 

Nintendo DS Lite  Oven PBX  PDA  PDA Accessory PS2 Game   

Plasma TV  Portable DVD Player Portable 

TV  Printer  Projection TV

 Projector   

Radar Detector  Radio Range  Receiver 

 Refrigerator Remote Control  

Router  Satellite Radio Satellite Receiver  Scanner  Security Camera Speaker   

Speaker System Storage Subwoofer  Switch  TV Tablet  

Tape Deck  Telephone Telescope 

 Turntable  VCR Vacuum 
Voice Recorder  Washer Watch 

 

Another benefit of the site is that it also will store 

your manuals for you. Is that great or what?  
At retrevo.com again later I learned that over 4 

million people visit the site every month to get help 
with decisions about the gadgets they buy. Retrevo is 
NOT a retailer and does not sell consumer electronics, 
but it uses artificial intelligence to analyze and visually 
summarize more than 50 million real-time data points 

from across the web; and gives shoppers 
comprehensive, unbiased, up-to-date product 
information about what products to buy as well as 
when and where to buy them. 

 

Contributed by:  
Dave Gerber 
7424 Cass Circle 
Sarasota, Fl 34231 
941-926-5388 (phone) 

PUSH@apcug.net 
Skype: floridamysticruler 

 
Need Computer Help? 

 

 
 

Visit our Help Desk and Discussion Group at 
http://tech.groups.yahoo.com/group/epcc/ 

 

Contribute a Newsletter Article 

All members are encouraged to submit 
articles or other items of interest for 
possible Newsletter publication.  

The deadline for articles to appear in the 
next issue is the 1st Monday of the month.  

All articles are gladly accepted at anytime 
for our future publication s.  

When you send your contribution  as an e -

mail attachment, please  save your text file 
in text  (*.txt) or MS Word Format (*.doc) ; 

Images  are  to be saved in Jpeg Format.  

Please send to: Stephanie Varis 

svaris@verizon.net   
 

 

mailto:PUSH@apcug.net
http://tech.groups.yahoo.com/group/epcc/
mailto:svaris@verizon.net
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Whoôs Who at EPCC 

 

 

Directors 
Isabelle Bourrie (484) 995-5012 ibourrie@voicenet.com 
 
Bob Linaberry (610) 873-0204 rl55@verizon.net 
 
Jim McKittrick (610) 647-8188 JMcKit@ccil.org 
 
Gabe Preston (610) 436-0311  GabePreston@comcast.net 

 
Salvatore Sano (610) 269-5096 SalvatoreSano@yahoo.com 

 
Michael Shephard       joelise@gmail.com 
 
 

Program Contacts 
Digital Imaging Bob Linaberry       rl55@verizon.net 

Microsoft Windows Doug Fairchild (610) 696-8223 
  db64fair@verizon.net 

 

Microsoft Publisher Jack Stretch (610) 363-6328 
  JLStretch@comcast.net 

 

Microsoft Office/Works Salvatore Sano 

Staff Positions 
Newsletter Editor Stephanie Varis      svaris@verizon.net 

 
Newsletter Mailing Sal Sano  SalvatoreSano@yahoo.com 

 

Communications Charlie Eisenfelder Caeilop@aol.com 

 

Membership Joseph Holzman  m28@verizon.net  

 

Treasurer Nate Rosenthal (610) 970-5122 
  n2add@arrl.net 

 

Webmaster    Bob Linaberry rl55@verizon.net 

 

CHESCO Library Liaison Diane Gring 

 
 

 

 

MEMBERSHIP 2010 
 

Thank you to those who have renewed.  
We welcome New Members who joined us! 
Please encourage family & friends to join...  

Please see the Exton PC Council 
membership form on the following pageé    

 

 

 
 

Are you interested in Becoming 
a Guest Speaker? 

We are greatly interested in bringing in 
new guest speakers!  Please contact us 

and share! We appreciate your 
participationé 

We are Seeking New 
Technology Interest Groups! 

If you want to start a new interest group in 
computer technology, web, photography, 

film-making, etc., please contact us!   

 
                       

mailto:ibourrie@voicenet.com
mailto:rl55@verizon.net
mailto:JMcKit@ccil.org
mailto:GabePreston@comcast.net
mailto:SalvatoreSano@yahoo.com
mailto:joelise@gmail.com
mailto:rl55@verizon.net
mailto:db64fair@verizon.net
mailto:JLStretch@comcast.net
mailto:svaris@verizon.net
mailto:SalvatoreSano@yahoo.com
mailto:Caeilop@aol.com
mailto:m28@verizon.net
mailto:n2add@arrl.net
mailto:rl55@verizon.net
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Your Membership Is Welcome! 
Non-members and former members are encouraged to join. 

Please fill in the Membership Application below and mail it with your check now!   

 

EXTON PC COUNCIL (EPCC) 2010 MEMBERSHIP APPLICATION / RENEWAL  
 
Membership includes email notices, privilege to post on EPCCôs Yahoo Groups, privilege to participate in 
special prize give away raffles at various meetings and affords additional benefits of special offers through the 
national APCUG (Association of Personal Computer User Groups). 

 

New Member: $25.00 ______ Renewal: $20.00 ______ Date_________________ 

Notice of downloadable ExtonPC.Org News will be emailed monthly ï Add $5.00 to above fees to 

receive copy by postal mail and mark here. ______ (To cover cost of postage and mailing) 

Last Name: _______________________________ First Name _______________________________ 
If you are a current member and renewing, fill in all changes only below.  Otherwise fill in all information. 

ADDRESS: ___________________________________________________ 

CITY: _________________________ STATE: ____ ZIP: ______________ 

HOME PHONE: _________________________ WORK PHONE: _____________________ (Optional) 

EMAIL (please update and print clearly): _____________________________________________________  

Please pay at the next main meeting, or mail this form with your check made payable to EPCC. 

Mail To: EPCC, 310 North High Street, West Chester, PA. 19380 

 
Exton PC Council 

310 North High Street 
West Chester, PA 19380 

http://www.extonpc.org 

Mailing 
Address 

Goes 

Here 

Place 
Postage 

Here 


